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E.1 Introduction

Readers who are studying MATLAB may want to explore the convenience of MATLAB’s
LTI Viewer, the Simulink LTI Viewer, and the SISO Design Tool. SISO is an acronym for
single-input single-output. Before proceeding, the reader should have studied Appendix B,
the MATLAB Tutorial, including Section B.1, which is applicable to this appendix.

MATLAB Version 8.3(R2014a), MATLAB’s Control System Toolbox Version 9.7,
Simulink Version 8.3, and Simulink Control Design Version 4.0 are required in order to use
the tools described in this appendix.

The M-files in this appendix are available elsewhere on this Web site. Consult
the MATLAB Installation Guide for your platform for minimum system hardware
requirements.

E.2 The LTI Viewer: Description

The LTI Viewer is a convenient way to obtain and view time and frequency response plots
of LTI transfer functions and obtain measurements from these plots. In particular, some of
the graphs the LTI Viewer can create are step and impulse responses, Bode, Nyquist,
Nichols, and pole-zero plots. In addition, the values of critical points on these plots can be
displayed with a click of the mouse. Table E.1 shows the critical points that are available for
each plot.

TABLE E.1 Critical points available for each plot in MATLAB’s LTI Viewer

Peak value: Steady  Gain/phase margins;
peak time Settling  Rise state zero dB/180° Pole-zero
or frequency time time value frequencies value
Step ° ° ° °
Impulse ° °
Bode ° °
Nyquist ° °
Nichols ° °

Pole-zero °
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E.3 Using the LTI Viewer

In this section we give you steps you may follow to use the LTI Viewer to plot time and
frequency responses. If you have trouble, help is available on the LTI Viewer window menu
bar and on the Status Bar at the bottom of the LTI Viewer window. Help is also available on the
Quick Access Toolbar at the top of the MATLAB R2014a window. Enter LTI Viewer in the
search box on the right. The following summarize the steps you may take to obtain plots from
the LTI Viewer.

1.

FIGURE E.1 LTI Viewer showing
right click pop-up menu

Access the LTI Viewer The LTI Viewer, shown in Figure E.1, may be accessed by
typing [ltiview in the MATLAB Command Window or by executing this command in
an M-file.

. Create LTI transfer function Create LTI transfer functions for which you want to

obtain responses. The transfer functions can be created in an M-file or in the MATLAB
Command Window. Run the M-file or MATLAB Command Window statements to
place the transfer function in the MATLAB workspace. All LTI objects in the MATLAB
workspace can be exported to the LTI Viewer.

. Select LTI transfer functions for the LTI Viewer Choose Import . . . under the File

menu in the LTI Viewer window and select all LTI objects whose responses you wish to
display in the LTI Viewer sometime during your current session.

. Select the LTI objects for the next reponse plot Right-click anywhere in the

LTI Viewer plot area to produce a pop-up menu as shown in Figure E.1. Under
Systems, select or deselect the objects whose plots you want or do not want to show in
the LTI Viewer. More than one LTI transfer function may be selected.

. Select the plot type Right-click anywhere in the LTI Viewer plot area to produce a

pop-up menu as shown in Figure E.1. Under Plot Types, select the type of plot you want
to show in the LTI Viewer.

. Select the characteristics Right-click anywhere in the LTI Viewer plot area to produce

a pop-up menu as shown in Figure E.1. Under Characteristics, select the characteristics

u LTI Viewer @@Iﬂ
File Edit Window Help
e =
Step Response
0.25 ! | | | i | b ! | | |
L e e T
o 0187 Right-click Plot T ’ i
2 Ignt-click pop-up menu ot Types
= Systems 4
o
g: 01k \ Characteristics  » |
' \ Grid
Normalize
005t v | Full View i
Properties ...
D 1 1 1 1 1 1 1 1 1
0 05 1 1.5 2 25 5 g1 4 45 5
Time (seconds)
Import completed. Systems imported: 1.
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of the plot you want displayed. More than one characteristic may be selected. For each
characteristic chosen, a point will be placed on the plot at the appropriate location.

7. Interact with the Plot:

Zoom in Select the Zoom In button (with the + sign) on the tool bar. Hold the mouse
button down and drag a rectangle on the plot over the area you want to enlarge. Let
go of the mouse button. You may also click the mouse. Each click zooms you in
closer.

Zoom out Select the Zoom Out button (with the — sign) on the tool bar. Click on the
plot. Each click widens your view.

Grid Select Grid in the right-click menu to toggle the grid on and off. The right-
click menu will not work if any zoom button on the tool bar is selected.

Normalize Select Normalize in the right-click menu to normalize all curves in view.

Full view Select Full View in the right-click menu to return to the full view of your
plot after zooming.

Characteristics Read the values of the characteristics by placing the mouse on the
characteristics point on the plot. Left-click the mouse to keep the values displayed.

Properties Select Properties in the right-click menu to change the appearance of the
graph. You can change the title, axis labels, x and y limits, font size and styles,
colors, and response characteristics definitions.

Coordinates and curve Left-click the mouse at any point on the plot to read the
system identification and the coordinates.

Add text and graphics Under the File menu, choose Print to Figure. The tool bar of
this figure has additional tools for adding text, arrows, and lines.

Additional plot-edit capabilities The Edit menus of the LTI Viewer and the figures
created by selecting Print to Figure offer a wide variety of control over the plot
presentation.

E.4 LTI Viewer Examples

This section presents five examples of the use of the LTI Viewer taken from Chapters 4, 10,
and 13. The examples will show the M-files along with the resulting LTI Viewer window.

Step Response

PROBLEM: This example, taken from Example 4.8 in the text, shows the use of the LTI
Viewer to display simultaneously three step responses as well as their peak time, settling
time, rise time, and steady-state values. Let us follow the steps listed in Section E.3.

Access the LTI Viewer and create the LTI objects Follow Steps (1) and (2) in Section
E.3 to access the LTI Viewer and generate the LTI transfer functions. Figure E.2(a)
shows the M-file used to generate the three transfer functions.

Select transfer functions for viewing responses  After running the M-file, follow Steps
(3) and (4) in Section E.3 and select T1, T2, and T3.

Select the plot type Follow Step (5) in Section E.3 and select Step.

Select the Characteristics Follow Step (6) in Section E.3 and select Peak Response,
Settling Time, Rise Time, and Steady State.

Interact with the plot Follow Step (7) in Section E.3 and interact with the plot. In
particular, read the peak value and peak time of T3’s step response. Figure E.2(b) shows
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the LTI Viewer window with the responses and system T3’s peak amplitude, percent
overshoot, and peak time.

'Exanple E.1' %¥Display label.
'LTI Viewer for Chaptexr 4, Example 4.8' tDisplay label.
'Step response' %Display label.
'Tl(s)' 5Display label.
TLl=t£(24.542,[1 4 24.542)) %Create TI.
‘Tz(s)! %Display label.
T2=tL£(245.42,conv ([l 10],[1 4 24.542])) %Create TZ2.
'T3(s)" 4Display label.
T3=tf£([73.626,conv([l 3],[1 4 24.542])) %¥Create T3.
leiview %Call up LTI Viewsr.
(@)
B LTI Viewer L [E=EER
File Edit Window Help
D&|R|E
Step Response
1.4 T T T d & T T T
System: T3
C-.ZIzZ:zA Peak amplitude: 1.04
12F / , Overshoot (%): 3.69 T
11 At time (seconds): 1.06
I e s e R R e
1/1 I [N
g 08r L o 1
';é L 1l
< UBr L 11 i
(I | [N
0.4F " ' Vo i
[ I [N
02t e L 1
[ I [N
0 I 1 | 1 I I 1
0 0.5 1 1.5 2 216 3 35
Time (seconds)
FIGUREE.2 LTI Viewer used Import completed. Systems imported: 3.

for step response: a. M-file;
b. LTI Viewer ®)

Nyquist Diagram and Gain/Phase Margins

PROBLEM: This example, taken from Example 10.8 in the text, shows the use of the LTI
Viewer in plotting a Nyquist diagram and obtaining gain margin, phase margin, zero dB
frequency, and 180° frequency. To create this plot follow Step (1) through (4) in Section E.3
using the M-file shown in Figure E.3(a). Then use the right-click menu and select Nyquist
under Plot Type. To find the gain and phase margins as well as the gain and phase margin
frequencies, use the right-click menu and select All Stability Margins under Character-
istics. Figure E.3(b) shows the resulting LTI Viewer window. The system’s gain margin and
180° frequency are displayed along with the phase margin and zero dB frequency.




ONLINEAPPE

11/22/2014 11:19:43  Page 5
E.4 LTI Viewer Examples
'Exanple E.2' iDisplay label.
'LTI Viewer for Chapter 10 Exomple 10.8°'
¥Display label.
'Wyquist diagram® sDisplay label.
nung=6; ¥Create numerator of G(s).
deng=convi{[Ll 2],[1 2 2)): 4Creace denoxinator of G{s).
Gle) ! %Display label.
G=cf (numy, deng) %Create and dizsplay G(s).
ltiview %Call wp LTI Viewex.
()
LTI Viewer [ESREERTX
File Edit Window Help
D& R <[E
Nyquist Diagram
1143 T T T T
1 - -
P i
- System: G -
e Gain Mardin (dBY. 10.5 N 1
o . At frequency (radis). 2.45 \
< Closed loop stable? Yes .
= Il
g oo Sewo B E e — R —
= T
=P ¥ System: '
£ N . Phase Margin (deg): 67.7 y
o5k “ Delay Margin{ (sec): 0.944 . -
S requency (radis). 1.25 L
- sed loop stable? Yes ~
|8 ——— - i
15 1 i 1 1
-1 05 0 05 1 1.5
Real Axis
Plot type changed.
®)

FIGURE E.3 LTI Viewer used
for Nyquist diagram: a. M-file;
b. LTI Viewer

Bode Plots and Gain/Phase Margins

PROBLEM: This example, taken from Example 10.10 in the text, shows the use of the
LTI Viewer in making a Bode plot and obtaining gain margin, phase margin, zero dB
frequency, and 180° frequency. To create this plot, follow Steps (1) through (4) in Section
E.3 using the M-file shown in Figure E.4(a). Then use the right-click menu and select
Bode under Plot Type. To find the gain and phase margins as well as the gain and phase
margin frequencies, use the right-click menu and select All Stability Margins under
Characteristics. Use the right-click menu and select Grid. Figure E.4(b) shows the
resulting LTI Viewer window. The system’s phase margin and 0 dB frequency are
displayed along with the gain margin and 180° frequency.
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FIGURE E4 LTI Viewer used
for Bode plot: a. M-file;
b. LTI Viewer
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‘Exanple E.3' ¥Display label,
‘LTI Viewer for Chaprer 10, Exawple 10.10'
sDisplay label.
'Bode plot! (Display label.
nung=200; tCreate numerator of G(s).
deng=poly([-2 -4 =5]): ¥Create denoninator of G(s).
‘Gls)! 3Display label.
G=tf (mug,deng) 3Create and display G{s).
lriview *Call up LTI Viswer.
(@)
B LTI Viewer [E=REE
File Edit Window Help
WEIEERYE
Nyquist Diagram
1.5 T :YC{ 2 T T

System:(‘,lb
Gain Mardin (dB). 10.5 N
At frequency (radis): 2.45 \
Closed logp stable? Yes '
_______ ey ISR

System: &

Imaginary Axis
2

N R Phase M argirh (deg): 67.7 y !
05F ~ Delay Margirl (sec): 0.944 B 4
- Atfrequency (radis): 1.25 L7
. Closed loop stable? Yes e
T s [ J
15 L | L |
-1 0.5 0 05 1 15
Real Axis
Plot type changed.

®)

Since Example 10.10 used asymptotic approximations to determine the character-
istics, such as gain and phase margin, there will be some discrepancy between the
characteristics found using the LTI Viewer, which uses the exact frequency response, and
the results of Example 10.10.

Example E4

Nichols Chart and Gain/Phase Margins

PROBLEM: This example, which reproduces Figure 10.47 in the text, shows the use of
the LTI Viewer in making a Nichols chart and obtaining gain margin, phase margin, zero
dB frequency, and 180° frequency. To create this plot follow Step (1) through (4) in
Section E.3 using the M-file shown in Figure E.5(a). Then use the right-click menu and
select Nichols under Plot Type.

To find the gain and phase margins as well as the gain and phase margin frequencies,
use the right-click menu and select All Stability Margins under Characteristics. Use the
right-click menu to select Grid. Finally, select Zoom In from the toolbar and drag your
mouse over a portion of the Nichols plot to create the close-up view shown in Figure E.5(D).
Figure E.5(b) also shows the points from which gain and phase margins and frequencies
can be read.
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'Exanple E. &' %Display label.
'LTI Viewer for Chapter 10, Figure 10.47'
%Display label.
'Richols chart' 3Display label.
nungs=1; tCreate numerator for G(s).
deng=poly ([0 -1 -2]): 3Create denominator for Gis).
'G(s)! %Display label.
G=tf (nung, deng) 5Create G(s).
leiview %Call up LTI Viewer.
(@)
B v - SE=)

File Edit Window Help

D& R | E

Nichols Chart

fim)

=

£

5

O .

o

8

5

5 - System: 6

2 Gein Margin (B3, 15.6

o ; At frequency (ratis): 1.41 Y .
30+ B Closed loop stablé? Yes ] i i 4
-40
E0f ; : : -
60 by ETTTT : : : feonenenene - o

-225 -180 -135 -90 -45

Open-Loop Phase (deg)

Plot type changed.

J|

®

FIGURE E.5 LTI Viewer
used for Nichols chart:
a. M-file; b. LTI Viewer

Step Response for Digital systems

PROBLEM: This example shows the use of the LTI Viewer to produce step responses for
digital system. To create this plot follow Steps (1) through (4) in Section E.3 using the M-file
shown in Figure E.6(a). Then use the right-click menu and select Step under Plot Type.
Figure E.6(b) shows the LTI Viewer window with the digital step response.

'Exanple E.S* %Display label.
'LTI Viewer for Chapter 13° 3Display label.

'‘Digital step response’ sDisplay label.

'Giz)!' %Display label.

G=tf£([1 -0.214],[1 -0.607],0.5) xCreate =anpled transfer funtion.
'"Tiz)’ ¥Display label.

T=G/ (L4G) ¥Calculate clozed-loop samplad

zeransfer function for unity
%feedback saunpled systex.
lciview 3Call LTI Viewer.

(@)

FIGURE E.6 LTI Viewer
used for digital step response:
a. M-file; (figure continues)




ONLINEAPPE  11/22/2014

FIGURE E.6
b. LTI Viewer

11:19:44

(Continued)

Page 8

Appendix E: MATLAB’s GUI Tools Tutorial

LTIViewer @Iﬂlﬂ
File Edit Window Help

D&|R[E

5 Step Response

19F B
18F B
1.7 F B
16F B
15F B

Amplitude

1.4+ .
131 .
1.2f .
111 .

1 1 1 1 1 1
0 2 4 B 8 10 12

Time (seconds)

Import completed. Systems imported: 1.

®

E.5 Simulink and the LTI Viewer

Readers who are using Simulink may use the LTI Viewer to obtain responses and their
characteristics directly from Simulink models. All of the response plots and characteristics
available to you in the LTI Viewer using transfer functions generated in MATLAB and
placed in the MATLAB workspace are available to you from your Simulink model. Any
nonlinear blocks in your Simulink model are linearized by the Simulink LTI Viewer before
presenting the requested response curve. You will be able to:

1. Set a point on your Simulink model where the input signal will be applied.
2. Set output points on your Simulink model where responses will be obtained.

3. Specify operating conditions, such as initial conditions and input value.

E.6 Using the LTI Viewer with Simulink

In this section we present the steps you may follow to use the LTI Viewer with Simulink.
Help is available on the menu bar of the MATLAB Window. Click on the encircled
question mark. When the help screen is available, choose Simulink Control Design. Help is
also available from Help on the menu bar of the Control and Estimation Tools Manager
Window. From Help select Simulink Control Design Help. The following summarize
the steps you may take to use the LTI Viewer with Simulink. We use the system from
Example C.3 to demonstrate.

1. Access a Simulink Model Start with your Simulink model window shown in Figure E.7

2. Define the input and output of your analysis model Click on the point to apply the
input. Right click on the selected point and choose Linear Analysis Points then Input
Perturbation on the drop-down menu. Next, click on the point to view the output. Right
click on the selected point and choose Linear Analysis Points then QOutput
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P2 apEsect * =&
File Edit View Display Diagram Simulation Analysis Code Tools Help
B8 0 BEG-E4OP @ o) @ -
apEsecé |
® apEsec6 v
_ Sum .
Q +$ w /~ I > num@ |1 > [
| +1.71 ’
E] Step Gain Saturation Motor, load, Scope
10 vols +5volts & gears E
—
] N ) _—
c.2: of a fe system with & nonlinearity
» 22
Ready 100% oded5 [

EE—

FIGURE E.7 Simulink model window showing Input Perturbation point and Output
Measurement point

Measurement on the drop-down menu. The input and output points are shown on the
Simulink model of Figure E.7.

3. Linearize the model Under the Analysis menu select Control Design followed by
Linear Analysis ... In response, MATLAB opens the Linear Analysis Tool
Window, Figure E.8. Select the Exact Linearization tab followed by pressing the
Linearize green arrow on the Toolstrip.

4. Launch the LTI Viewer After linearization, the LTI Viewer is launched in the Linear
Analysis Tool window as shown in Figure E.9. All of the LTI Viewer functions
previously described are now available.

4\ Linear Analysis Tool - apEsec6 L Lﬂm

ver

ULTS

Data Browser ®
Search workspace variables L '|

w MATLAB Workspace |

Name « Value
G L tf -
H L tf
@ T Lt £
@ T1 Lt
@ T2 WLt
IRl WLt o

W Linear Analysis Workspace |

Name « Value

W Variable Preview

FIGURE E.8 Linear Analysis Tool window
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& Linear Analysis Tool - apEsec6 - Step Plot 1 E@u
LINEAR ANA,.. EXACT LINEARIZ... FREQUENCY RESPONSE ESTIM... E
Analysis /Os: Modellios v| /5% Plot Result: ’ New Step ¥ E
Options:
Operating Point:  Model Inftial Condition ~ g 2 Lnearize
SETUP GENERATE RESULTS
Data Browser ® | [ Step Plot1 ]
Search workspace variables 2 " Step Response
w MATLAB Workspace ‘ From: Sum To: Motor, load, & gears
1 T T T T T T T
Name « Valwe | | linsys1
@] 6 DA - 09F
@[ H At [
@] T Lt e g 1
@] 11 bt - a7 |
< [ »
W Linear Analysis Workspace ‘ 2 0B T
S
Name ~ Value ‘-:_ 051 T
linsys1 Ixlss E 04k i
03 E
02r E
< i »
0.1 E
W Variable Preview ‘
0 | | | 1 L | |
0 0.05 0.1 0.15 0.2 0.25 03 0.35 0.4
Time (seconds)

FIGURE E.9 Linear Analysis Tool window after linearization showing inserted LTI Viewer

E.7 The SISO Design Tool: Description

The SISO Design Tool is a convenient and intuitive way to obtain, view, and interact with a
system’s root locus and Bode plots. The tool also has the option of using a Nichols chart,
which can be selected under the View menu. After the tool produces these plots, you can do
the following with the root locus: (1) drag closed-loop poles along the root locus and read
gain, damping ratio, natural frequency, and pole location, (2) view immediate changes in the
Bode plots, and (3) view immediate changes in the system’s closed-loop response via the
LTI Viewer for SISO Design Tool window. You can add poles, zeros, and compensators,
which can be interactively changed to see the immediate effects on the root locus, Bode
plots, and time response.

You can do the following with the Bode plots: (1) effect a gain change by moving the
Bode magnitude curve up and down and reading the gain, gain margin, gain margin
frequency, phase margin, phase margin frequency, and whether the loop is stable or
unstable, (2) view immediate changes on the root locus, and (3) view immediate changes in
the system’s closed-loop response via the LTI Viewer for SISO Design Tool window. You
can add poles, zeros, and compensators, which can be interactively changed to see the
immediate effect on the Bode plots, root locus, and time response.

Finally, you can add root locus or Bode plot design constraints that are then displayed
on the respective plot.

E.8 Using the SISO Design Tool

In this section we present the steps you may follow to use the SISO Design Tool. If you have
trouble, help is available by selecting SISO Design Tool Help under the SISO Design for
SISO Design Task window Help menu. Context-sensitive help also is available. Select the
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SISO Design for SISO Design Task [E=REER
File Edit View Design Analysis Tools Window Help
(x o ¥ ||
Root Locus Editor for Open Loop 1(OL1)  Open-Loop Bode Editor for Open Loop 1(0OL1)
1
05 105
e
0
0.5
: D56 M.: inf
-11 o D i Freq: NaN
Bode Editor for Closed Loop 1(CL1) p Stable loop
0 1
5 05
-10 0
1
0 0.5
P.M.: -180 deg
. Freq: O rad/s
10" 10° 10? 10° 10°
Frequency (rad/s) Frequency (rad/s)
Right-click on the plots for more design options.

FIGURE E.10 SISO Design for SISO Design Task window

context-sensitive tool (the arrow and question mark) from the SISO Design for SISO
Design Task window, move it to the item on the SISO Design for SISO Design Task
window about which you have a question, and click. The explanation will appear in the
Help window. Help is also available on the Status Bar at the bottom of the SISO Design
Tool window. Finally, screen tips are available for the toolbar buttons. Let your mouse’s
pointer rest on the button for a few seconds to see the explanation. The following summarize
the steps you may take to use the SISO Design Tool.

1. Access the SISO Design Tool The SISO Design for SISO Design Task window,
shown in Figure E.10, may be accessed by typing sisotool in the MATLAB Command
Window or by executing this command in an M-file.

2. Create LTI transfer functions Create open-loop LTI transfer functions for which you
want to analyze closed-loop characteristics or design compensators. The transfer
functions can be created in an M-file or in the MATLAB Command Window. Run
the M-file or MATLAB Command Window statements to place the transfer functions
in the MATLAB workspace. All LTI objects in the MATLAB workspace can be
exported to the SISO Design Tool. For this example we run an M-file and generate the
LTI object for G(s) = (s + 8)/[(s + 3)(s + 6)(s + 10)].

3. Create the closed-loop model for the SISO Design Tool Choose Import . . . under
the File menu in the SISO Design for SISO Design Task window to display the System
Data window shown in Figure E.11(a).

11
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B System Data 5

Import Model

System Data

G 1

H 1

C 1

F 1
[ 0K ][ Cancel ][ Help ]
(@

rModeIImport u

Import model for |G

Import from:

@ Workspace

(©) MAT File:

|[ Browse..

Available Models

Type

Order

Import H Close H Help ]

®)

FIGURE E.11 a. The System Data window b. The Model Import window

Type the LTI transfer function in the Data column. Alternately, click the Browse . . .
button and select the function you want to analyze in the resulting Model Import window
shown in Figure E.11(b). Click Import followed by Close in the Model Import window.
Click OK in the System Data window.

4. Interact with the SISO Design Tool After the System Data window closes, the SISO
Design for SISO Design Task window now contains the root locus and Bode plots for
the system as shown in Figure E.12.

You can now add the window to your desktop from which you can immediately view
closed-loop responses as you make changes to the root locus or Bode plot. Under the
Analysis menu select the desired response to open the LTI Viewer for SISO Design Task
window. Be sure to right-click on the LTI Viewer for SISO Design Task and choose
Systems to display the system response you desire. See the earlier Task sections of this

appendix for information on the LTI Viewer.
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SISO Design for SISO Design Task [E=NEER
File Edit View Design Analysis Tools Window Help
NEEEEREERIL
Root Locus Editor for Open Loop 1(OL1)  Open-Loop Bode Editor for Open Loop 1(OL1)
20 -20
10
og—-—o------B——Wt----------
-10
-100 G.M.: inf
-2010 8 B 4 2 Freq: Inf
Bode Editor for Closed Loop 1(CL1) 1 Stable loop
. 0
50 “ﬁ»\\_\ ]
-45
-100 \\ _
-150 L : \\ -80
D T
| 1-135
<0 \ P.M.: inf
. Freq: NaN
A o — 5180 2 5 ) 4
10 10 10 107 10° 10 10 10
Frequency (rad/s) Frequency (rad/s)
Applied new configuration. Right-click on the plots for design options.

FIGURE E.12 SISO Design for SISO Design Task window

Changing gain  You may change the loop gain in three ways. (1) Grab a closed-loop
pole (red squares) on the root locus. When the arrow cursor changes to a hand, hold down
the left button of your mouse and drag the closed-loop pole along the root locus. You will
see immediate changes on the Bode plot and the closed-loop response in the LTI Viewer
for SISO Design Task window. The value of gain will be displayed in the Status Bar at the
bottom of the SISO Design for SISO Design Task window. (2) The loop gain can also be
changed by positioning the cursor over the open-loop Bode magnitude plot until it changes
to a hand. Hold down the left button of your mouse and drag the Bode magnitude plot up
or down. You will see immediate changes on the root locus and closed-loop response.
(3) Finally, the gain can also be changed by choosing Design in the SISO Design for SISO
Design Task menu bar and then selecting Edit Compensator . . . When the Control and
Estimation Tools Manager window appears, type the desired gain in the Compensator
Editor section and hit enter. As you change the gain, notice that you can read the gain and
phase margins and the gain and phase margin frequencies at the bottom of the Bode
magnitude and phase plots. Also, at the bottom of the Bode magnitude plot you are told
whether or not your closed-loop system is stable.

Grids You may toggle the root locus and Bode plot grids on and off by right-
clicking in the respective plot’s window and selecting or deselecting Grid. The root locus
grids are damping ratio and natural frequency.

Zoom See the instructions for zooming in Section E.3, using the LTI Viewer.

Design constraints You may add design boundaries on your plots. For example, if
you want the settling time to be less than 2 seconds, a vertical gray bar immediately to the
right of —2 will signify the boundary for that portion of the root locus where the settling

13
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SISO Design for SISO Design Task (e [z
File Edit View Design Analysis Tools Window Help
NEEEERIEEYIL
L 22222 £ E3 %‘
S = 3 ]
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FIGURE E.13 SISO Design for SISO Design Task window toolbar

time does not meet the requirements. These constraints may be selected by right-clicking
a respective plot and selecting Design Requirements. Choose whether you want a
New . . . constraint or you want to Edit . . . an existing constraint. Constraints may also
be edited on the plots. Position your cursor at the boundary of the constraint. Left click and
when it turns into a four-pointed arrow, you can drag the boundary to a new position. The
values of the constraints are displayed in the Status Bar at the bottom of the plots.

Properties Right-clicking in a plot’s window and selecting Properties . . . dis-
plays the Property Editor window. From this window you can control some properties of
the plot, such as axis labels and limits. There are other options available. For instance, you
may change the damping ratio grids to show percent overshoot by right-clicking in the root
locus window and selecting Properties ... Once the Property Editor window is
displayed, click the Options tab and select Display damping values as % peak overshoot.
You may want to explore other options available for the root locus and Bode plots.

Add poles, zeros, and compensators Poles and zeros may be added from the SISO
Design Tool for SISO Design Task window toolbar shown in Figure E.13. Use the SISO
Design for SISO Design Task toolbar and select the desired compensator pole or zero. Your
cursor shows that a pole or zero was selected. Point your cursor arrow to the point on the root
locus or Bode plot where you want to add the compensator and click. The compensator is
shown in the Control and Estimation Tools Manager window under the Compensator
Editor tab. The effect of adding the compensator is immediately seen in the root locus, Bode
plots, and LTI Viewer for SISO Design Task windows. You may change the way the
compensator is represented by going to SISO Tool Preferences . . . under the Edit menu.
Select the Options tab and choose the compensator format you want.

Editing compensators The pole and zero values of the compensators can be edited in
several ways. (1) Place your cursor over a compensator zero or pole on the root locus or Bode
plot. When the cursor changes to a hand, hold down the left button of your mouse and drag the
pole or zero to a new position. (2) Choose Design then Edit Compensator . . . on the SISO
Design for SISO Task window menu bar. In response, MATLAB produces the Control and
Estimation Tools Manager. Under the Compensator Editor tab you can type in another
location for compensator zeros and poles. (3) Poles and zeros can be erased using the eraser on
the tool bar in Figure E.13. Select the eraser with your mouse and click on the pole or zero you
wish to erase. The effect of editing the compensator is immediately seen in the root locus, Bode
plots, and LTI Viewer for SISO Design Task response window.

Other options and windows There are other options and windows available that
may be important to your project. You are encouraged to explore other menu items not
discussed in this section.

This appendix described three MATLAB GUI tools: the LTI Viewer, the Simulink LTI
Viewer, and the SISO Design Tool.
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We described how to use MATLAB’s LTI Viewer to obtain time and frequency
response plots, as well as critical points on those plots, for transfer functions within the
MATLAB workspace. Several examples covering step responses for continuous and
sampled systems, Nyquist diagrams, Bode plots, and Nichols charts were given.

In addition, several preferences that we did not describe are available from the LTI
Viewer Edit menu. Within that menu, choose Plot Configurations . . . to select a response
layout. Line Styles . . . allows you to change the color, marker, and line style orders. The
interested reader should consult the Control System Toolbox reference listed in the
Bibliography of this appendix for more details about options not covered in this appendix
as well as additional instruction about the LTI Viewer.

The Simulink LTI Viewer extends the usefulness of the LTI Viewer to Simulink
diagrams. Simulink models are linearized before presenting the response curves in the
Simulink LTI Viewer. You may set the input and output points at any appropriate place
on the Simulink diagram. Y ou may make changes to the Simulink diagram and simultaneously
display the response of each mode in the Simulink LTI Viewer.

The SISO Design Tool is a convenient and intuitive way to obtain, view and interact
with a system’s root locus, Bode plot, and Nichols plot. You can move closed-loop poles
along the root locus and immediately read the values of gain, locations of closed-loop poles,
and characteristics of performance, Furthermore, you can see the changes in the open-loop
frequency response as well as the closed-loop response if you have the LTI Viewer for SISO
Design Task open. Gain also can be adjusted on the open-loop frequency response plots, and
the effect can be seen immediately on the root locus and closed-loop responses. Finally, you
can add compensators and see the immediate effect on the root locus, open-loop frequency
response plots, and the closed-loop responses.

In conclusion, it should be pointed out that results obtained from the GUIs might be
different from the analysis presented in the chapters. For example, the GUIs use non-
asymptotic frequency response plots to obtain results, while our analysis and design may
have used asymptotic Bode plots. Another example is settling time. In Chapter 4 we
approximated the settling time so that it was measured at the peaks. With the GUISs the actual
settling time is used, that is, the time the curve first enters and stays within the +2%
boundary.
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